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Introduction

MorFishJ is an open-source software package for traditional morphometric analysis of fish
in ImageJ. With MorFishJ you can collect morphological trait data from fish images in a
standardised and reproducible way through a semi-automated procedure, which accelerates
data collection and increases data accuracy by reducing user bias.

Motivation

While advances in modern morphometrics (landmarks configuration and outline analysis) have
increasingly facilitated data acquisition and analysis, traditional morphometrics has not kept
pace. Collection of traditional morphometric data from fish images is generally slow and not
reproducible. A typical workflow in ImageJ is:

1. Open an image.
2. Adjust the image if necessary (or do this beforehand with another software).
3. Draw reference lines to help with trait measurement (Optional).
4. Measure traits one by one.
5. Save results.
6. Close the image (losing track of the work done).
7. Open the next image and repeat the procedure.

Additionally, traits are often defined and measured differently by different researchers as a
standardised protocol does not exist yet, making it impractical to merge data obtained from
multiple studies.

The MorFishJ package

MorFishJ allows users to perform a complete morphometric characterisation in a limited time
while recording and storing all steps, and saving results in a ready-to-use format suitable
for statistical analysis with multiple software. Analyses of large photographic databases are
facilitated by allowing users to stop and restart their analyses without losing progress.

To cite MorFishJ in publications use:
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Mattia Ghilardi (2022). MorFishJ: A software package for fish traditional morphometrics. Zenodo. https://doi.org/10.5281/zenodo.6969273

A BibTeX entry for LaTeX users is:

@software{,
author = {Mattia Ghilardi},
title = {{MorFishJ: A software package for fish traditional

morphometrics}},
year = 2022,
publisher = {Zenodo},
doi = {10.5281/zenodo.6969273},
url = {https://doi.org/10.5281/zenodo.6969273}

}

About this manual

This manual is a step-by-step user guide to MorFishJ. It explains best practices for project
organisation, walks through each implemented analysis, and provides detailed explanations
and examples for specific steps.

Versioning

The manual follows the same versioning of MorFishJ. For each new release of MorFishJ this
manual will be updated and will be given the same version number.

The latest version of the manual can always be accessed at https://mattiaghilardi.github.io/
MorFishJ_manual/.

Previous versions can be accessed at:

• v0.2.1
• v0.2.0
• v0.1.0

A list of changes made for each version of MorFishJ can be seen here.
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1 Installation

ImageJ is an open source image processing program commonly used by researchers to extract
morphometric data from fish images. As such, MorFishJ has been developed as an extension
of this software and it can be used in both ImageJ 1.x and Fiji (ImageJ2) distribution.

Therefore, the installation of ImageJ (instructions here) or Fiji (instructions here) is required
before installing MorFishJ.

Warning

MorFishJ depends on ImageJ 1.53s, thus, if ImageJ/Fiji was previously installed, first
check the current ImageJ version below the toolbar. If it is older than 1.53s, to update
ImageJ click Help –> Update ImageJ…, choose the latest version and click OK. Then
ImageJ/Fiji must be restarted.

Once ImageJ/Fiji is installed/updated, proceed with installing MorFishJ following these
steps:

1. Download MorFishJ v0.2.2 from here as a ZIP file.
2. Extract the content.
3. Copy the folder named MorFishJ (NOT the entire downloaded folder) in the

ImageJ/plugins/ or Fiji.app/plugins/ directory.

Now MorFishJ is installed. Open ImageJ/FIJI and click Plugins –> MorFishJ –> Mor-
FishJ GUI. The Graphical User Interface (GUI) (Chapter 2) of MorFishJ appears in the
upper left corner of the screen.

Tip

In Fiji the Plugins menu is often crowded, thus it may be easier to use the Search field
under the toolbar to find and start MorFishJ.
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2 GUI

The GUI of MorFishJ provides a simple and direct access to all the morphometric analyses.
Each analysis can be started by clicking on the appropriate button.

2.1 Morphometric analyses

Three morphometric analyses are currently available in MorFishJ:

Main Traits

The workhorse of MorFishJ. Performs a complete morphometric analysis measuring 22
traits that cover all body parts visible from side view images, excluding dorsal, pelvic,
and anal fins.
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Head Angles

It allows to measure three head angles related to vision and feeding (Brandl and Bellwood
2013; Bellwood et al. 2014; Brandl, Robbins, and Bellwood 2015).

Gut Traits

It allows to measure three intestinal traits related to fish diet (Ghilardi et al. 2021).

2.2 Single and multiple image analysis

Each analysis has three different buttons:

• Single Image: to analyse only one image (may be useful for beginners to get used to
each step before analysing the entire image database).

• Multiple Images…New: to start a new analysis of an image database.
• Continued Analysis: to continue analysing an image database from where it was last

left.

2.2.1 Single Image

Warning

An image must be opened before starting a single image analysis.

Clicking on the Single Image button of the desired analysis before opening an image will
display the following message.

To open an image click on File –> Open… or use the shortcut Ctrl+O or drag the image
over the ImageJ main window.
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Once the image is opened, click on the Single Image button of the desired analysis. The
image is duplicated and all the following steps will be performed on the duplicated image to
avoid any unwanted modification of the raw image. The ROI Manager window is automatically
opened and the first dialog box appears, to either set the scale or adjust the image, depending
on the type of analysis selected.

The steps required to perform the selected analysis are explained in:

• Chapter 5: Main Traits
• Chapter 6: Head Angles
• Chapter 7: Gut Traits

2.2.2 Multiple Images

New analysis

Before starting to analyse an image database the new project should have a clear folder struc-
ture. MorFishJ does not require a fixed folder structure, but only an input directory where the
raw images are stored and two output directories, one to save the Regions Of Interest (ROIs)
and one to save the results and log files (although the same output directory could be used for
all outputs). Therefore, you can set your own folder structure. However, it is advisable that
each project has its own directory with the following structure.

./ProjectName/
��� raw_images
� ��� img1.JPG
� ��� img2.JPG
� ��� img3.JPG
� ��� ...
��� results
��� ROIs

There are three subdirectories: one containing the raw images, one to save the ROIs and
processed images, and one to save the results and log files.

Important

Do NOT use the same directory as both input and output! This would prompt an error
when trying to continue the analysis loading the TraitLog file.

To start a new analysis click on the Multiple Images...New button of the desired analysis.
The following dialog box appears.
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Use the Browse button to add the path to the input directory where the raw images are
stored, and the output directories where the ROIs and results will be saved. Alternatively, it
is possible to drag the directories over the dialog box. By default the results file will be named
Traits and will be saved in .csv format, but it is possible to change both the name and the
extension, which can be changed to .txt through the drop-down list.

Once all the fields are completed click OK. Two files are created in the selected directory for
the results:

• a log file with the name TraitLog followed by the date of creation in dd_mm_yyyy format
and including all the metadata required to restore the project.

• a results file with the selected name and extension. Results are appended to this file at
the completion of the analysis of each image.

Important

Do not edit the TraitLog file by hand and do not change its directory!

The first image in the input directory is automatically opened and duplicated. All the following
steps will be performed on the duplicated image to avoid any unwanted modification of the raw
image. The ROI Manager window is automatically opened and the first dialog box appears, to
either set the scale or adjust the image, depending on the type of analysis selected.

The steps required to perform the selected analysis are explained in:

• Chapter 5: Main Traits
• Chapter 6: Head Angles
• Chapter 7: Gut Traits
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Continued analysis

It is possible to stop and restart each analysis without losing progress. Everything done until
the last completed image is saved, thus, if the analysis is stopped before completing an image,
only the steps performed on that image are lost.

To continue a project from where it was last left, click on the Continued Analysis button of
the desired analysis. The following dialog box appears.

Use the Browse button or drag the file over the dialog box to add the path to the TraitLog
file of the project. Thus click OK. The project is restored and can be continued from the next
image. The new results will be appended to the existing results file.
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3 Image scale

The first step of the Main Traits and Gut Traits analyses is to set the scale for the im-
age. While for the Main Traits analysis this is optional, it is required for the Gut Traits
analysis.

3.1 Main Traits scale

When starting the Main Traits analysis the following dialog box appears.

There are three options:

• Add a scale through a reference object in the image.
• Add a scale through the known length of the fish.
• Do not add a scale to the image.

Check the box of the appropriate option to add a scale, or leave the boxes empty and click
OK to continue without adding a scale. If both options are selected, a reference object will be
used.

Scale through reference object

After selecting Reference object the following dialog box appears.

Trace a straight line on a reference object and click OK. The next dialog box appears.
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Enter the known length of the traced line and select the unit from the drop-down list. Three
options are available (mm, cm, and inch), but any unit will then be converted to cm. The
traced line will be stored in the ROI Manager as px.cm and then saved with all other ROIs.
The scale of the image, in pixels/cm, will be saved in the results file within the column px.cm
to allow converting the results, which are saved in pixels, to cm, if preferred.

Scale through fish length

After selecting Known fish length the following dialog box appears.

Enter the known length of the fish, select the unit from the drop-down list, and select the
type of length, either standard length or total length, from the drop-down list. As for the
reference object, the scale of the image, in pixels/cm, will be saved in the results file within the
column px.cm to allow converting the results, which are saved in pixels, to cm, if preferred.
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3.2 Gut Traits scale

The procedure to add a scale to the Gut Traits analysis is the same as using a reference scale
in the Main Traits analysis.

When starting the Gut Traits analysis the following dialog box appears.

Trace a straight line on a reference object and click OK.

Tip

For the Gut Traits analysis the reference object could also be the fish itself if it is in
the image and its length (standard, fork, or total) is known. In this case trace a line over
the fish to select the appropriate length.

The following dialog box appears.

Enter the known length of the traced line and select the unit from the drop-down list. Three
options are available (mm, cm, and inch), but any unit will then be converted to cm. The
traced line will be stored in the ROI Manager as px.cm and then saved with all other ROIs.
The scale of the image, in pixels/cm, will be saved in the results file within the column px.cm
to allow converting the results, which are saved in cm, to the original pixels, if preferred.
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4 Straighten and rotate

Two analyses, Main Traits and Head Angles, require the fish to be in a straight and horizontal
position. For such analyses the software allows to adjust the image if required. For the Main
Traits analysis this is the second step, after adding the scale as described in Chapter 3,
whereas for the Head Angles analysis it is the first step. The following dialog box appears.

It allows to select one of two options:

• Straighten: to straighten the fish if it is in a bent position.
• Rotate: to rotate the image and set the fish in an horizontal position.

Therefore, if the fish is not straight and horizontal, select the appropriate option and click OK.
Otherwise, click OK without selecting any option and continue.

Straighten

When the fish is bent, select Straighten and click OK. The following dialog box appears
together with the Line Width window.

Follow the instructions given in the dialog box, create a segmented line selection, increase
the line width until the whole fish falls within the shaded area and click OK. The fish will
be straightened and in an horizontal position. The following figure shows an example of fish
straightening.
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4.1 Before
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4.2 After

Tip

Selecting Spline fit within the Line Width window can improve the selection and
straightening of the fish.

Warning

If the fish is overly bent, straightening can lead to deformation of the body which affects
the measurement of the traits. Use this option with care.

Rotate

When the fish is straight but not horizontal, select Rotate and click OK. The following dialog
box appears.

Follow the instructions given in the dialog box, trace a line and click OK. The image will be
rotated and, if the line was placed well, the fish will be in an horizontal position. The following
figure shows an example of image rotation.
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4.3 Before
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4.4 After
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5 Main Traits

The Main Traits analysis is the workhorse of MorFishJ as it performs a complete morphome-
tric characterisation of fishes. It requires the user input to trace the outline of the body and
pectoral fin, and to position some reference lines (Figure 5.1, Table 5.1) and landmark points.
The coordinates of these lines and points allow to extract 22 morphometric measurements
described in Figure 5.2 and Table 5.2.

Figure 5.1: Reference lines traced on fish images for main traits analysis (see Table 5.1 for
descriptions)

Table 5.1: Description of reference lines traced on fish images for main traits analysis

Reference line Description User input
A Vertical line at the narrowest point of the

caudal peduncle
Yes

B Horizontal line touching the highest edge of
the body (excluding fins)

No

C Horizontal line touching the lowest edge of
the body (excluding fins)

No
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Reference line Description User input
D Vertical line touching the most anterior tip

of the body
No

E Vertical line touching the most posterior tip
of the caudal fin

No

F Horizontal line touching the highest edge of
the caudal fin

No

G Horizontal line touching the lowest edge of
the caudal fin

No

H Vertical line at the base of the caudal fin
(end of the vertebral column or posterior
edge of the hypural plate). Parrotfishes
(Labridae: Scarini) are an exception and the
line should be placed between the last and
second to last scale lying along the midline
(FishBase)

Yes

I Vertical line touching the posterior margin
of the operculum

Yes

J Horizontal line cutting the eye in halves No1

K Vertical line cutting the eye in halves No
L Vertical line at the pectoral fin insertion Yes

Table 5.2: Description of morphometric parameters taken on fish images

Code Trait Description Reference
TL Total length Length from the most

anterior point of the
body (D) to the most
posterior point (E)
(excluding the caudal
filaments)

FishBase

SL Standard length Length from most
anterior point of the
body (D) to the the base
of the caudal fin (H)

FishBase

1The user has to trace an ellipse around the eye and lines J and K will be automatically drawn from the
coordinates of this selection.
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Code Trait Description Reference
MBd Maximum body

depth
Body depth at the
deepest part of the body
(excluding fins).
Measured as the vertical
distance between B and
C

Bellwood et al.
(2014)

Hl Head length Horizontal distance from
most anterior tip of the
head (D) to the
posterior margin of the
operculum (I)

Barnett, Bellwood,
and Hoey (2006)

Hd Head depth Head depth measured at
the vertical of the orbit
centroid along K

Villéger et al.
(2010)

Ed Eye diameter Internal diameter of the
orbit measured along J

Bellwood et al.
(2014)

Eh Eye position Vertical distance from
the orbit centroid (J ×
K) to the bottom of the
body (K × C)

Toussaint et al.
(2016)

Snl Snout length Horizontal distance from
the anterior margin of
the orbit to the tip of
the snout (D)

Barnett, Bellwood,
and Hoey (2006)

POC Posterior of orbit
centroid

Horizontal distance from
the orbit centroid (J ×
K) to the posterior
margin of the operculum
(J × I)

Bellwood et al.
(2014)

AO Anterior of orbit Horizontal distance from
the anterior margin of
the orbit to the anterior
margin of the body
along J (AO may be
close, or equal to, zero in
species with very
anterior eyes)

Bellwood et al.
(2014)

EMd Eye-mouth distance Distance between the
orbit centroid (J × K)
to the anterior tip of the
premaxilla

Bellwood et al.
(2014)

22



Code Trait Description Reference
EMa Eye-mouth angle Angle between EMd and

a horizontal line
intersecting the tip of
the premaxilla

Bellwood et al.
(2014)

Mo Oral gape position Vertical distance from
the tip of the premaxilla
to the bottom of the
body (C)

Toussaint et al.
(2016)

Jl Maxillary jaw
length

Length from the tip of
the premaxilla to the
intersection between the
maxilla and the
mandible (i.e. the corner
of the mouth)

Toussaint et al.
(2016)

Bs Body surface area Area of a polygon drawn
following the contour of
the body excluding fins,
and up to the narrowest
point of the caudal
peduncle

Bellwood et al.
(2014)

CPd Caudal peduncle
depth

Measured at the
narrowest point of the
caudal peduncle along A

Villéger et al.
(2010)

CFd Caudal fin depth Maximum depth of the
caudal fin

Villéger et al.
(2010)

CFs Caudal fin surface
area

Area of a polygon drawn
following the contour of
the caudal fin, with the
anterior margin marked
by a straight vertical
line through the
narrowest point of the
caudal peduncle

Villéger et al.
(2010)

PFs Pectoral fin surface
area

Area of a polygon drawn
following the contour of
the pectoral fin

Villéger et al.
(2010)

PFl Pectoral fin length Length of the longest ray
of the pectoral fin

Toussaint et al.
(2016)
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Code Trait Description Reference
PFi Pectoral fin position Vertical distance from

the upper insertion of
the pectoral fin to the
bottom of the body (C)

Toussaint et al.
(2016)

PFb Body depth at level
of pectoral fin
insertion

Body depth measured
along L

Villéger et al.
(2010)

5.1 Analysis

Once the steps described in Section 2.2 are completed the screen will be populated with a
number of windows:

• the ImageJ/Fiji main window
• the MorFishJ GUI
• a fish image (this is a duplicate of the raw image to prevent any modification)
• the ROI manager
• the Image scale dialog

While the majority of the analysis is automated, there are a number of steps that require the
user input:

1. If available, add a scale to the image as described in Chapter 3.

2. Adjust the image if necessary as described in Chapter 4.

3. Select the orientation of the fish (i.e., whether the fish is facing left or right) from a drop-
down list. This step is important for the correct automatic placement of some reference
lines and points.

4. Select the fish outline following the instruction in the dialog. Trace a polygon around
the body and caudal fin, excluding the dorsal, pelvic, and anal fins as in the example
below. Also avoid including any portion of pectoral fin protruding from the body area.
Once the selection is completed it can be adjusted as needed.

Tip

The points that define the selection can be moved. To add a new point to the selection
press Shift and click on an existing point. To remove one point press Alt and click on
the point. See Polygon Selection Tool.
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(a) Linear measurements

(b) Surface areas

Figure 5.2: Morphometric parameters taken on fish images (see Table 5.2 for descriptions)
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5. Position reference line A at the narrowest point of the caudal peduncle. After clicking
OK several automatic steps will split the outline in two, the body area (Bs) and caudal
fin area (CFs), and add reference lines B-G.

6. Position reference line H at the base of the caudal fin to mark the end of the standard
length.

7. Position reference line I at the posterior margin of the operculum.

8. Trace an ellipse around the eye as in the example below (see Elliptical Selection Tool for
specific instructions on how to use this tool). After clicking OK two new reference lines
(J-K) are drawn perpendicular intersecting at the eye centroid.

9. Place a point at the insertion of the pectoral fin as in the example below.

After clicking OK reference line L appears passing through the selected point and 14 new traits
are drawn and added to the ROI manager together with all reference lines.

Note

Update from v0.2.2.
In fish with very anterior eyes, or positioned on top of the head (e.g. Periophtalmus spp.
and many other blennies), the anterior edge of the orbit may lie outside the body outline.
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In such cases AO = 0 and the ROI for AO is not saved.

10. Select the outline of the pectoral fin as in the example below. After clicking OK this is
saved in the ROI manager as PFs.

11. Trace a line on the longest ray of the pectoral fin. After clicking OK this is saved in the
ROI manager as PFl.

12. Place a point at the tip of the premaxilla (upper jaw) as in the example below. After
clicking OK a new trait (Mo) is drawn and saved in the ROI manager.

13. Place a point at the corner of the mouth.

Important

The point should be placed at the intersection between the maxilla and the lower jaw (fish
skull anatomy), not where the flesh of the upper and lower jaw meet! See the example
below.
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5.2 Correct

5.3 Incorrect

After clicking OK the last three traits are drawn and saved in the ROI manager.

The analysis of the image is completed. In case of single image analysis a window named
Traits containing all the results appears. This can be saved by clicking on File -> Save
As.... All ROIs in the ROI manager can also be saved as a zip file by clicking on More >>>
-> Save.... In case of multiple image analysis a new row will be added to the results file,
the ROIs are saved in their directory, where also the rotated or straightened images are saved
as .jpg files. The current image is closed and the next is opened. Repeat steps 1-13 for all
images.
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5.4 Results

The results file/table contains one row for each image and 25 columns. The first column,
image_id, is the name of the image without extension. The second column, px.cm, is the
scale of the image in pixels/cm. This will be NA for images without scale. The columns 3-24
are the morphometric measurements described in Table 5.2. All linear measurements are in
pixels and all areas in pixels2. The angle EMa is in degrees. The last column, time, is the time
spent to analyse the image (steps 1-13) in seconds.
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6 Head Angles

The Head Angles analysis allows to extract three angles (Figure 6.1, Table 6.1) related to vi-
sion and feeding (Brandl and Bellwood 2013; Bellwood et al. 2014; Brandl, Robbins, and Bell-
wood 2015) from the coordinates of some reference lines and points (Figure 6.2, Table 6.2).

Figure 6.1: Angles measured on fish head (see Table 6.1 for descriptions)
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Table 6.1: Angles measured on fish head

Code Trait Description Reference
Ha Head angle The angle formed by a line

connecting the tip of the
premaxilla (P1) to the point
where line L5 crosses the
upper margin of the snout
and a line connecting the
latter point to the
intersection between lines L3
and L4

Brandl and
Bellwood (2013)

Sa Snout angle The angle formed by the two
lines drawn to the tip of the
premaxilla (P1) from the
point where line L5 crosses
the upper and lower margins
of the snout

Brandl and
Bellwood (2013)

EMa Eye-mouth angle The angle formed by a line
connecting the tip of the
premaxilla (P1) to the eye
centroid and a horizontal line
intersecting P1

Bellwood et al.
(2014)

Table 6.2: Description of reference lines and points traced on fish images for head angles anal-
ysis

Reference
line/point Description User input
P1 Anterior tip of the premaxilla (upper jaw) Yes
L1 Horizontal line cutting the eye in halves No1

L2 Vertical line cutting the eye in halves No
L3 Vertical line touching the anterior margin of the eye No
L4 Horizontal line touching the upper margin of the

eye
No

L5 Vertical line half way between L3 and P1 No

1The user has to trace an ellipse around the eye and lines L1-L4 will be automatically drawn from the
coordinates of this selection.
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Figure 6.2: Reference lines and points traced on fish images for head angles analysis (see Ta-
ble 6.2 for descriptions)

6.1 Analysis

Once the steps described in Section 2.2 are completed the screen will be populated with a
number of windows:

• the ImageJ/Fiji main window
• the MorFishJ GUI
• a fish image (this is a duplicate of the raw image to prevent any modification)
• the ROI manager
• the Image adjustment dialog

This analysis has six steps that require the user input:

1. Adjust the image if necessary as described in Chapter 4.

2. Select the orientation of the fish (i.e., whether the fish is facing left or right) from a drop-
down list. This step is important for the correct automatic placement of the reference
lines.

3. Place a point at the tip of the premaxilla (upper jaw) as shown below. After clicking OK
this is saved in the ROI manager as P1.
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4. Trace an ellipse around the eye as shown below (see Elliptical Selection Tool for specific
instructions on how to use this tool). After clicking OK five reference lines (L1-L5) are
drawn and saved in the ROI manager together with the ellipse (eye).

5. Place a point at the intersection between line L5 and the dorsal margin of the snout
as shown below. After clicking OK the first angle (Ha) is drawn and saved in the ROI
manager.

6. Place a point at the intersection between line L5 and the ventral margin of the snout as
shown below. After clicking OK the other two angles (Sa, EMa) are drawn and saved in
the ROI manager.

The analysis of the image is completed. In case of single image analysis a window named
Traits containing all the results appears. This can be saved by clicking on File -> Save
As.... All ROIs in the ROI manager can also be saved as a zip file by clicking on More >>>
-> Save.... In case of multiple image analysis a new row will be added to the results file,
the ROIs are saved in their directory, where also the rotated or straightened images are saved
as .jpg files. The current image is closed and the next is opened. Repeat steps 1-6 for all
images.

6.2 Results

The results file/table contains one row for each image and 5 columns. The first column,
image_id, is the name of the image without extension. The columns 2-4 are the angles
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described in Table 6.1 in degrees. The last column, time, is the time spent to analyse the
image (steps 1-6) in seconds.
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7 Gut Traits

The Gut Traits analysis allows to measure three intestinal traits related to fish diet (Ta-
ble 7.1).

Table 7.1: Morphometric parameters measured on fish intestine (see Figure 7.1)

Code Trait Description Reference
GL Gut length Length of the intestine from

the pyloric outlet to the anus
in fishes with a stomach, or
from the oesophagus to the
anus in stomachless fishes

Ghilardi et al.
(2021)

GD Gut diameter External diameter of the
intestine (average of 10
measurements: GD1-GD10)

Ghilardi et al.
(2021)

GS Gut surface area External surface area of the
intestine calculated as GL x
2𝜋(GD/2)

Ghilardi et al.
(2021)

Figure 7.1: Morphometric parameters taken on fish intestine

7.1 Analysis

Once the steps described in Section 2.2 are completed the screen will be populated with a
number of windows:
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• the ImageJ/Fiji main window
• the MorFishJ GUI
• a fish image (this is a duplicate of the raw image to prevent any modification)
• the ROI manager
• the Set scale dialog

This analysis has a few steps that require the user input:

1. Set the scale for the image as described in Chapter 3.

2. Trace a segmented line following the midline of the intestine as shown below.

After clicking OK 10 points appear equally distributed along this line.

3. At the level of the point closest to the oesophagus, trace a straight line perpendicular to
the midline traced in the previous step and joining the two margins of the intestine.

4. Repeat step 3 for each point in order moving towards the anus. See example below.

The analysis of the image is completed. In case of single image analysis a window named
Traits containing all the results appears. This can be saved by clicking on File -> Save
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As.... All ROIs in the ROI manager can also be saved as a zip file by clicking on More >>>
-> Save.... In case of multiple image analysis a new row will be added to the results file
and the ROIs are saved in their directory. The current image is closed and the next is opened.
Repeat steps 1-4 for all images.

7.2 Results

The results file/table contains one row for each image and 16 columns. The first column,
image_id, is the name of the image without extension. The second column, px.cm, is the
scale of the image in pixels/cm. The columns 3-5 are the traits described in Table 7.1 in cm
(cm2 for GS). The columns 6-15 are the 10 raw measurements of the diameter (GD1-GD10) in
order from the oesophagous to the anus. The last column, time, is the time spent to analyse
the image (steps 1-4) in seconds.
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